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Course Objectives 

• Overview of the NBRSS and NBS

• Oracle Basics

• Travel Payment Processes

• Important Dates and Activities 
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Agenda

1. Discuss NBRSS and NBS Project
2. Short Introduction to Oracle
3. Travel Payment Process
4. Hands-on Exercises
5. Wrap Up
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Training Guidelines 

1. Ask Questions

2. Cheating is encouraged

3. Don’t let me get ahead

4. Have fun!
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Questions

Questions?
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How to Use the Manual

Each Student Guide contains a Table of Contents
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How to Use the Manual

Each Chapter constitutes a lesson
Each lesson has a set of objectives
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How to Use the Manual

The lessons contain information on the business processes as well as 
step-by-step instructions on how to perform tasks in the NBS
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How to Use the Manual

Step-by-step instructions on
how to perform tasks in the
NBS are contained in
“Navigation” documents.

Navigations:
1. May contain a Purpose or 

Prior Activity section
2. Contain a Navigation Box 

on the first page
3. Contain a picture of the 

screen that you will use to 
enter the data

1

2

3
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How to Use the Manual 
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Navigation Boxes describe how to get to the appropriate screen in 
Oracle to perform the task

Navigation Boxes are always followed by a screen shot of the window 
you will navigate to.

NIH Receivables Customer Entry Oracle Responsibility

N > Customers > Standard Navigation Path
Find/Enter Customers                                            Screen Name

How to Use the Manual
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How to Use the Manual

1. Directive 
statements will 
help you 
determine your 
next step.  The 
statements are 
indicated in Bold

2. Words in Bold
font indicate a 
field, window, or 
button name

2

1
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How to Use the Manual

The shaded fields indicate that the entry is optional or that you should 
accept the default values

If a field is not referenced, you should not change the default value.
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How to Use the Manual

Notes provided after the task instruction provide useful information or 
helpful hints to complete the step.
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How to Use the Manual

The end of the 
task will be 
indicated by 
End of Activity.
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How to Use the Manual

Each lesson concludes with a Lesson Summary
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NIH Business System (NBS) – How it all 
started

Project began in FY 1999 with the development of a comprehensive business 
case to replace NIH’s Administrative Data Base (ADB).

ADB -- An integrated data base that services most of NIH’s administrative and 
support functions.

Central Accounting, Accounts Payable, Travel, Property, Acquisitions/Supply, 
Contracts, and Service and Supply Fund activit ies.
Transactions feed the accounting system from the point of origin, i.e., 
procurement requisition, travel order, etc.
Used by about 5,000 NIH employees, most of w hom are in the Intramural 
Research Program.
Processes approximately 150,000 transactions each day.

Work groups comprised of 200 NIH employees helped with the NIH decision to 
go with a commercial Enterprise Resource Planning (ERP) product.

The challenge is not to design software but to adapt NIH business practices to 
the “best practices” embedded into the commercial ERP product.
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NBRSS Project Objectives

NBRSSNBRSS

NBSNBS EHRPEHRP

2 web-based systems to provide administrativ e support to NIH’s scientific 
mission
Links the NIH accounting structure with administrative and scientific support 
functions
Incorporates industry standard “best practices”

Integrates NIH’s core administrative functions
Finance – Scheduled Deployment 10/1/03
Travel – Scheduled Dep loyment 9/1/03
Propert y
Acquisition/Supply
R & D Contracts
Service & Supply Fund 

Replaces the current Administrative       
Database (ADB)

Improves Human Resources and benefits 
management and planning across DHHS and 
NIH
Modernizes the processing of Human  
Resources actions
Replaced the DHHS Human Resources 
system (IMPACT)

Deplo yed 
9/9/02!
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Project Manage r
Colleen Barros

(NBRSS)

Functional 
Managers

Leslie Siddeley (NBS)
Jan Maltbie (EHRP )

Technical 
Managers

Carol Perrone (CIT)
Jack Vinner (CIT)

Systems
Integrator

Tom Breue r
(BearingPoint)

Change
Manager

Susan Corey
(NBRSS)

Functional
Team

Membe rs
(NBRSS)

Technical
Tea m

Membe rs
(NBRSS)

Functional, Technical 
and Change 

Management
Team 

Membe rs
(BearingPoint)

Resource Tea ms
(NIH IC/OD )

Change Mgmt
Tea m

Represents formal lines of authority:
•Funct. Teams -NBRSS employees reporting to FM
•Tech. Tea ms -CIT employees reporting to TM
•BearingPoint employees report to SI 
•CM-NBRSS employees reporting to Director
•Each, in turn, reports to Project Manager
•Functional Advisory Committee and Resource 
Team me mbers a re IC/ OD e mployees 
serving on ad hoc basis
•Steering Committe e is top policy making body

Functional Advisory 
Committees

(NIH IC/OD )

Change Management
Advisory 

Committee
(NIH IC/OD )

Administrative Manage ment Systems Stee ring
Committee (A MSSC)

IV&V

NBRSS Governance Structure
20 NIH Le aders+ 1 DHHS Rep.

140 End-users

66 Ma nagers

& Superv isors
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NBS NBS -- An Integrated SystemAn Integrated System

Property Property 

TravelTravel

AP/AR  AP/AR  
PurchasingPurchasing

InventoryInventory

Projects Projects 
R&DR&D

ContractsContracts

(Gelco)(Gelco)

(Sunflower)(Sunflower)
(CompuSearch)(CompuSearch)

(Oracle & CompuSearch)(Oracle & CompuSearch)
(Oracle)(Oracle)

(Oracle)(Oracle)

(Oracle)(Oracle)

(Oracle)(Oracle)

General Ledger / General Ledger / 
Budget ExecutionBudget Execution
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NBS – How it Works
Typically, transactions proceed horizontally across several administrative 
functions.

Administration uses the NBS to purchase a piece of equipment for a scientist.

In real time, this information automatically transmits to f inance to check funds 
availability; obligate funds; and once the equipment is received, pay the bill.

Upon receipt this information automatically f lows to property to track the equipment.

Why an integrated system? 
Eliminates multiple entries;
Minimizes the potential of errors;
Provides accurate reports; and 
Eliminates the expense and technical diff iculty of linking together systems that are 
dedicated to individual functions.
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Expected Benefits of the NBS

One integrated system, linking each of the major 
business functions, including human resources;

Better integration and sharing of information within the 
organization; 

Improved managerial control and access to key data; and

Improved financial statements and management reports 
across NIH, using the new Accounting Classification 
Structure (ACS).
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Realities of the NBS

NBS replaces a dying system – something had to be done.  NBS offers a 
modern-day feel, but no system is perfect, and the NBS will not solve 
everything.

NBS is not a proprietary system – we’re bound by the software, and 
customizations are costly.

There will be a phased conversion period, so we will not experience the full 
functionality and benefits all at once.  As pieces of the current system are 
shut down and the new system is set up, there will be disruption.

The administrative, legal, and regulatory policies outside of the NBS remain.

To reap the full benefits of the NBS, local IC policies and approval levels may 
need to be reevaluated.

The NBS project is not operating independently – it is influenced by various 
Department initiatives.
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Track 1 Activities: General Ledger/Budget

NBS General Ledger replaces the CAS as the system of 
record

New projects (former CANs) are created

Budgets are entered based on the new accounting 
structure
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Sample Track 2 Activities: Travel 

NBS Travel System 
Enter, approv e, and electronically  route trav el documents, such as authorizations and 
v ouchers.

Accounts Payable
Process pay ments to trav elers and trav el management centers f or expenses entered in the 
NBS Trav el Sy stem
Maintain the database of trav elers and banking inf ormation

Accounts Receivable
Establish a list of  sponsors that is ref erenced by  the NBS Trav el Sy stem
Track amounts due f rom and paid by  non-f ederal organizations that sponsor trav el

Cash Management
Reconcile inv oices from TMC f iles to expenses entered in the NBS Trav el Sy stem and 
processed in Accounts Pay able

General Ledger/Fed Admin
Collect data from all f inancial subledgers
Record in-kind contributes from sponsors
Enter manual journal v ouchers
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Lesson Objectives 

In this lesson, you will learn how to:

• Access the NIH Portal to Log into Oracle

• Identify main areas of the Oracle windows

• Identify important toolbar buttons and menu paths

• Search for existing records

• Exit Oracle
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Accessing the NIH Portal 

In this lesson, you will learn how to:

Access the NIH Portal to log into Oracle

• Identify main areas of the Oracle windows

• Identify important toolbar buttons and menu paths

• Search for existing records

• Exit Oracle
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Accessing Oracle via the NIH Portal

Oracle is a web-based application available via the NIH Portal

NIH Portal website:  http://my.nih.gov
To Log on use your:

NIH Domain
User Name
Password

For assistance, contact NIH Help Desk at 6-HELP (301.496.4357)

Add the Budget & Finance Community, which is the page where the 
Oracle application resides

Select the NBS Production link to launch the application.
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Logging in to the NIH Portal

 
Follow the steps below to access the NBS Travel System application from the NIH Portal. 
• Launch Internet Explorer.  In the browser, navigate to the NIH Portal at http://my.nih.gov. 

(Note: If you need Internet Explorer installed on your computer, please contact the NIH Help Desk at 
6-HELP (301-496-4357))  

• Log onto the NIH Portal according to the steps listed below, using the account information you 
currently use to log on to Windows at your workstation. 

• Select your domain from the pull-down menu. (Hint: Use the "Which domain 
should I select? link for assistance.)  

• Enter your User Name. 
• Enter your Password. 
• Click the Log in button. 

 
For Portal account and password assistance, contact the NIH Help Desk at 6-HELP  
(301-496-4357) 
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Adding a Community to your NIH Portal View

1

2

3

4

5

 
What is a Portal Community and how do I subscribe to a Portal Community? 
 
Portal Communities provide content, documents and application access to users who have a 
common area of interest.  Once you subscribe to a community, it will appear in the list on your 
Communities tab every time you visit the NIH portal.  Follow the steps below to subscribe to a 
community. 
 
1.  Click on the “Communities” tab and select “Edit Your Memberships”.  
2.  Locate a community of interest either by clicking a folder to browse for communities or by 

entering a key word in the Search field and clicking "Go" to look for a specific community. 
3.  Once you locate a community of interest, select it by clicking in the box next to the 

community name. 
4.  Click “Add to my Memberships”. (You may need to select your default community.) 
5.  Click “Finish”.  The subscribed community will now appear in the list on your 

“Communities” Tab every time you access the portal.  
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Form Terminology 

In this lesson, you will learn how to

• Access the NIH Portal to Log into Oracle

Identify main areas of the Oracle windows

• Identify important toolbar buttons and menu paths

• Search for existing records

• Exit Oracle
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Form Terminology

The first step in understanding the system is to understand the layout of the 
screens and fields.

Toolbar

Menu Bar

Window 
Title bar

Tool
tip

Window

Status Bar

 
Form Terminology 
Oracle Applications Release 11i works specifically in a Web-enabled environment. It is 
important to understand the terminology of the components within an Oracle Applications form. 
Common terms used in Oracle Applications forms are listed below. 
Menu bar—Use pull-down menus from this menu bar to navigate or perform actions within a 
form 
Toolbar – Use icons from the bar to navigate or perform actions within a form 
Window—An area where the user interacts with an application (Many windows can be open at 
one time and you can access these “overlapping” windows to perform data entry or data search 
activities.) 
Window title bar—Text in the title bar that indicates the name of the window, and usually, 
context information pertinent to the information in that window 
Tool tip—Iconic bubble help that you can use to determine the function of a button on the 
toolbar.  Appears when cursor is held over the icon. 
Status Bar - The status line displays status information and pertinent information for processing 
your form.  
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Form Terminology

Region

Button

Region tab

Field

 
Form Terminology (continued) 
Region—A logical grouping of fields set apart from other fields by a box outline 
Region tab—A collection of regions that occupy the same space in a window where only one 
region can be displayed at a time 
Field—An area in a window that displays data or enables you to enter data 
Button—A graphic element that initiates a predefined action when you click it 
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Form Terminology

Option
button

Modal
window

Block

Scrolling 
region

 
Form Terminology (continued) 
Option button—A button that indicates an individual selection is available within an option 
group 
Modal window—A window that requires you to act on its content before continuing 
Scrolling region—A region, containing a scroll bar, in which to view other fields 
Block—An area of information relative to a specific business function or entity 
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Field Colors

Field colors indicate the attributes of the field.

Allow data entryWhite

Indicate fields to use in Query-Enter modeBlue

Are display onlyGray with black text

Require data entryYellow

Indicate drill-down capabilityWhite with Green Text

DescriptionField Color

 
What Field Colors Indicate 
Each block contains fields you use to enter, view, update, or delete information. A field prompt 
describes each field by telling you what kind of information appears in the field or what kind of 
information you should enter in the field. Fields are color coded to indicate their type as follows: 
White Fields—allow data entry 
White Fields with Green Text—indicate drill-down capability 
Yellow Fields—require data entry 
Gray Fields with Black Text—are display-only 
Blue Fields—indicate fields to use in Query-Enter mode 
The term field generally refers to a text field, an area in a window that either displays data or 
allows you to enter data. However, a field can also include a button, check box, option group, or 
poplist. 
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List of Values

Click the LOV icon
in the field

The list of 
valid values
is displayed

 
Using the LOV 
The List of Values (LOV) feature is very useful while entering data in Oracle Applications. It 
provides you with a powerful, easy-to-use data entry method that increases your accuracy and 
productivity. Using the LOV makes data entry an easy task for novice users, and experienced 
users can enter correct data with a minimum number of keystrokes. 
 
Oracle Applications notifies you when a list of acceptable input values is available for a field by 
displaying the LOV icon in the field. When you display a list, the values appear in a window 
with a title that describes the contents. 
 
By using the LOV feature, you can save time and enter data quickly without having to memorize 
or look up valid data for each field. You can choose data from an online list of valid input 
choices whenever you want. Additionally, you are relying on Oracle Applications to validate 
your input since you will know right away if your entry does not match an option from the LOV.  
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List of Values Auto Selection

 
AutoSelection 
Using the LOV feature called AutoSelection you can select a valid name from the list with a 
single keystroke. When you display the list window, you can type the first character of the name 
you want in the Find field. If only one choice begins with the character you enter, AutoSelection 
selects the choice, closes the list window, and enters the value in the appropriate field. 
 
List Search 
You can use the AutoReduction feature to reduce a list when you know the first few characters 
of your name selection. If you do not know the initial characters of your choice, but do know that 
your choice contains a certain word or set of characters, you can perform a list search to reduce a 
list. 
In the list window, enter any group of characters as search criterion in the Find field and click the 
Find button. You can use wildcard characters such as the percent sign (%) which represents any 
number of characters, or an underline (_), which represents a single character in your search 
criterion. 
For example, to reduce a list to only those choices that contain the phrase “schedule,” you would 
type %schedule% in the Find field and click Find. In any of these list search queries, it does not 
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matter whether you use uppercase or lowercase letters as the search is not case sensitive. Oracle 
searches all of the columns in the list. 
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Long-List Fields

 
Long-List Fields 
If a field has a “long-list”—that is, a list of more than 100 values—when you try to display the 
LOV, Oracle Applications will display a window where you can enter list reduction criteria. 
Because it takes less time to display a reduced list than a complete long-list, Oracle Applications 
prompts you to enter the first few characters that occur in your value of interest to reduce the 
complete list. However, to view the entire long-list, enter the percent sign (%) at the prompt and 
all of the values will be displayed. 
Note: To avoid excessive network traffic and reduced performance, try to enter specific criteria, 
other than just a percent sign (%), whenever possible. 
 
Power List 
The Power List feature provides an even faster method of data entry. If a field displays a List 
icon and you know the value you want, simply enter the first few characters of the value in the 
field and press [Tab]. Power List will complete the entry for you. You can also include wildcard 
characters with your entry. You do not need to display the list window. If more than one value 
matches the characters you specify, a list window containing those values is displayed. If no 
values match the characters you enter, a list window containing all the values appears. 
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Using Calendars

Selecting the LOV in date fields will display the calendar

Choose a 
month

Choose a 
year

Choose a 
day

 
Choosing a Date in the Calendar Window 
Values in a date field can be typed directly or you can use a calendar to enter a valid value in a 
date field if the field displays the LOV icon. If your date field supports time, you can also use 
the Calendar window to choose a valid time with the date. 
1. Put your cursor in a date field. 
2. Click the List icon to display the Calendar window. The date value that appears below the 
calendar is called the selected date, which is either the value already in the field, the default 
value of the field, or the current system date. 
3. Click on a date.  

Note: Disabled buttons that show dimmed text represent invalid days, which cannot be 
chosen. Similarly, if a date field is display only, you can display the Calendar window 
for the field, but you cannot change the date shown on the calendar. 

4. Click OK to accept the selected date and close the window. 
5. Click Cancel if you want to close the window without choosing a date. 
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Application Toolbar 

In this lesson, you will learn how to

• Access the NIH Portal to Log into Oracle

• Identify main areas of the Oracle windows

Identify important toolbar buttons and menu paths

• Search for existing records

• Exit Oracle
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Application Toolbar

• New
• Find
• Show 

Navigator

• Save
• Next Step
• Print
• Close Form

• Cut
• Copy
• Paste
• Clear Record
• Delete

• Edit Field
• Zoom
• Translations
• Attachments
• Folder Tools

Help

Tool
tip

 
Using the Toolbar 
The toolbar is a collection of iconic buttons, where each button performs a specific action when 
you choose it. Each toolbar button replicates a commonly-used menu bar item. Depending on the 
context of the current field or window, a toolbar button can be enabled or disabled. You can 
display help or a tool tip for an enabled toolbar button by holding your mouse over the button. 
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File, Edit, and View Menus

 
M > File 
Save—Saves any pending changes in the active form. 
Save and Proceed—Saves any pending changes in the active form and advances to the next 
record.  
Export—Exports information in your current form to a browser. 
Switch Responsibility—Allows you to change the responsibility in effect for your current log 
on. 
Print…—Prints your current window.  
Close Form—Closes all windows of the current form. 
Exit Oracle Applications—Quits Oracle Applications. 
 
M > Edit 
Undo Typing—Undoes any typing done in a field before the field is exited and returns the field 
to the most recent value. 
Clear Record—Erases the current record from the window.  
Clear  
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 Field—Clears the data from the current field.  
 Block—Erases all records from the current block.  
 Form—Erases any pending changes from the current form.  
Select All—Selects all records (for blocks with multi-select). 
 
M > View 
Show Navigator—Displays the Navigator window.  
Find All—Retrieves all records.  
Requests—Displays the Request window.  
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Searching for Existing Records 

In this lesson, you will learn how to

• Access the NIH Portal to Log into Oracle

• Identify main areas of the Oracle windows

• Identify important toolbar buttons and menu paths

Search for existing records

• Exit Oracle
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Using the Find Window

Specify 
search 
criteria

Click the
Find button

 
Using the Find Window 
1. (M) View > Find or click the Find icon on the toolbar. 
2. Enter your available search criteria in the appropriate fields of the Find window. 

If a field does not provide a list of values for you to choose from, you can enter wildcard 
characters (% and _) in the search phrase. You cannot, however, use query operators 
(such as >, <, and so on) in a Find window. 

3. Click the Find button to find any matching records. 
4. Click the Clear button to clear the current search criteria from the Find window so you can 
enter new search criteria. 
5. Click the New button to enter a new record in your current block if your search finds no 
matching records. Not all windows support this. 
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Query Results 
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Query Results

Your search results will be displayed on the screen.  
Your status bar will indicate the total number of records ret rieved.

 
Reviewing Your Data 
 
After a search, Oracle Applications retrieves any records that matched your search criteria. 
Always enter the most selective search criteria that you can.  
 
How to Review Retrieved Records 
 
Use the scroll bar or the down arrow on your keyboard to view additional records currently not 
visible on the screen in a multirecord block. 

(M) View > Record First to see the first record. 
(M) View > Record Last to see the last record. 

Note: Scrolling through records and using the Record Last command uses significant 
system resources. Avoid this by entering selective search criteria. 
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Searching for Data Using Query Mode

 
1. Select the F11 key (Fields turn blue) 
2. Enter your search criteria, using % wildcard 
3. Select the Ctrl + F11 keys 
4. Review the retrieved records 
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Exiting Oracle 

In this lesson, you will learn how to

• Access the NIH Portal to Log into Oracle

• Identify main areas of the Oracle windows

• Identify important toolbar buttons and menu paths

• Search for existing records

Exit Oracle
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Logging Out of Oracle

(M) File > Exit Oracle Applications
Use this method so that your username is cleared from 
system access.

 
Exiting Oracle Applications 
(M) File > Exit Oracle Applications, to log off the system. It is important to exit the system in 
this manner, rather than any other, as this is the only way to ensure that your user name is cleared 
from system access. 
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Logging Out of Oracle 
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Logging Out of Oracle

Close the Oracle Applications 11i window by selecting the X in the upper
right hand corner.
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Lesson Summary

In this lesson, you learned how to

• Access the NIH Portal to Log into Oracle

• Identify main areas of the Oracle windows

• Identify important toolbar buttons and menu paths

• Search for existing records

• Exit Oracle
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Processing Travel-Related 
Payments 
Chapter 5 
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Processing Travel-Related Payments 

Processing Travel-Related Payments

Track 2 End User Training
September 2003
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Lesson Objectives 

After this lesson you should know how to:

• Process travel-related payments

• Void a payment

 



 

Processing Travel-Related Payments   
 Chapter 5 - Page 4  

Process travel-related payments 
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Process travel-related payments 

After this lesson you should know how to:

Process travel-related payments

• Void a payment
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Cashier Payments Reference

All payments for Travel Documents beginning with TR
will be made from the NBS

The Cashier’s Office will continue to process other payments in the 
Cashier Tracking system
As of 9/1/03, travelers use the NBS Travel System to process travel 
documents for FY04.

ADB
ADB
ADB
NBS

System

09All other payments

06 & 07SF44 - Miscellaneous Vendor

03, 04, 05Travel Payments – starting with W

03, 04, 05Travel Payments – starting with TR

Current Cashier 
Tracking System 

Code

Description

 
Travel-related payments made by the NIH Remote Cashiers are generally limited.  Before a 
travel payment is issued from the remote cashier’s office, the traveler or travel planner must get 
prior approval from OFM’s Travel Office. 
 
Foreign Travelers:  Payments to foreign travelers may be generated by the cashier’s office and 
then express mailed to the traveler.  This alternative is available for those individuals that do not 
have an active U.S. bank account. 
 
In extraordinary circumstances, payments to employees and other NIH-affiliated individuals for 
travel expenses may be processed from the Cashier’s desk.  Such payments must first be 
approved by the OFM travel office. 
 
All other payments will continue to be processed through the Cashier’s Tracking System 
within the ADB. 
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Travel Payments Paid through Cashier’s 
Office

Travel payments that may be paid through the Cashier’s Office include:
Payments to foreign travelers

Travel planner submits a certified travel voucher to the cashier
Cashier’s Office generates a third-party draft and records it in the NBS
Travel planner express mails the payment to the foreign traveler

Emergency travel advances to NIH employees
Traveler requests emergency advance from OFM Travel Office
OFM Travel Office ensures the payment hasn’t already been processed 
and places it on Cashier Payment hold
Traveler presents approved travel authorization to the cashier
Cashier’s Office validates that the payment has been authorized for cashier 
pick up, generates a third-party draft, and records the payment in the NBS
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Sample Travel Authorization with Advance

Traveler 
Name and 
Address

Trip Purpose 
& Trip Type

Authorized 
Advance

Document NoDocument 
Type
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Travel Advances and AP Prepayments

Travel Authorization Number = AP Prepayment Number - AD

Travel 
Authorization 

Number

AP 
Prepayment 

Number

 
The Invoice Number in Accounts Payable will be associated with the travel document number 
listed on the travel document 
Cashiers should use the travel document number to locate the invoice in Accounts Payable most 
effectively 
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Sample Foreign Travel Voucher

Document Type

Traveler Name and 
Address

Trip Purpose & 
Trip Type

Net Due to Traveler
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Travel Vouchers and Travel-Related Invoices

Travel Voucher Number = AP Invoice Number

Travel 
Voucher 
Number

AP Invoice 
Number

 
The Invoice Number in Accounts Payable will be the Travel Voucher Number listed on the 
travel document. 
 
Cashiers should use the Travel Voucher number to locate the invoice in Accounts Payable most 
effectively. 
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Travel-Related Payment Process 
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Travel-Related Payment Process

Travel document  
presented to 
Cashier

Traveler or IC 
representative 
presents travel 
authorization or 
voucher and valid id

Cashier Records 
Payment

1. Locate and Review 
Invoice

3.  Record Payment

4.  Print Receipt

2.   Release Holds 
and Validate

Cashier Disburses 
Payment

Review Documents

Stamp document as 
paid

Disburse Payment

File Voucher

1. Locate and 
Review Invoice

 
The numbered steps are activities conducted within the NBS System. 
Non-numbered steps are actions taken outside the NBS System. 
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Locating a Travel-Related Invoice 

Page 10

Locating a Travel-Related Invoice

Navigate to N > Invoices > Entry > Invoices

Enter Travel 
Document Number

Press FIND

1. Locate and 
Review Invoice

 
When you navigate to the invoices form, the Find Invoices window automatically is displayed. 
 
Enter the travel document number in the Invoice Number field. 
 
When you select the Find button, your search results are display 
 
Select the Find button. 

Result:  The Invoices window will display the invoice. 
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Travel-Related Invoice 
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Travel-Related Invoice

Search results are displayed in the Invoices window.
Invoices designated for cashier pickup are on hold.
Select the Holds button to view the type of hold.

Hold Indicator

1. Locate and 
Review Invoice

Select Holds to 
view hold type

 
Invoices to be paid by the Cashier’s Office will always be on-hold. 
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Patient Travel Invoice

The type of hold should be Cashier Payment 1. Locate and 
Review Invoice

 
If the hold is anything other than Cashier Payment, you should not process the payment. 
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Patient Travel Invoice 
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Patient Travel Invoice

Payment Method should be Check. 1. Locate and 
Review Invoice
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Releasing the Hold  
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Releasing the Hold

You must release the hold first through the Actions
button.

2. Release Holds and 
Validate

 
When you select the OK button in the Invoice Actions window, the hold will be released and 
you are returned to the Invoices window. 
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Releasing the Hold 
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Releasing the Hold

Once the invoice is released from its hold, 
the invoice will be ready for validating.

Hold 
Released

2. Release Holds and 
Validate
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Validating the Invoice   
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Validating the Invoice 

You will validate the invoice through the Actions
button.

2. Release Holds and 
Validate

 
When you select the OK button in the Invoice Actions window, the invoice will be validated. 
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Validating the Invoice 
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Validating the Invoice 

Once the invoice is validated, the invoice 
will be ready for payment.

Validated

2. Release Holds and 
Validate
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Recording a Payment

Recording a payment in Oracle 
indicates that the payment was 
made from a separate system.
Process third-party draft from 
CDWS as it is done today.
To record payment, simply click 
on the Actions button in the 
Invoices window and select Pay 
in Full.

3.  Record Payment
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Payments Window  
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Payments Window

You will record the payment in the Payments
window. 3.  Record Payment

 
The first window that will appear is the Enhanced Transaction Events window. 

•  For travel vouchers, the correct transaction event is B110. 
•  For travel advances, the correct transaction event is B206. 

After select the transaction event, you will enter the payment information and save the record. 
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Printing the Receipt

The final step is to print the
receipt from the Invoices
window.

Close the payment window.
Select the Actions button in 
the Invoices window.
Select Print Notice
Select the printer.
Click OK.

4.  Print Receipt
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Recording Non-Patient Travel Payments 

Purpose 

The purpose of this document is to describe how to process non-patient travel payments from the 
cashier's office. 

NIH Payables Cashier Office User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter the AP invoice number corresponding to the document number in the Invoice: 
Number field and select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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2. Select the Holds button to review the status of the payment. 

Result:  The Invoice Holds window is displayed. 

 



 

Processing Travel-Related Payments   
 Chapter 5 - Page 25  

If a "Cashier Payment" or "Patient Recorded Pay" hold has been placed on the invoice, 
goto task #3. Otherwise, end of activity. 

3. Close the Invoice Holds window. 

Result:  You are returned to the Invoices window. 

4. Using the horizontal scroll bar, scroll to the right to view the Payment Method field. 

If the payment method is check, goto task #7. Otherwise, goto task #5. 

5. In the Payment Method field, use the LOV to select Check. 

6. Save the changes 

7. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 

 

8. Select the Release Holds checkbox. 

Result:  All is displayed in the Hold Name field. 

9. In the Release Name field, use the LOV to populate this field. 

Result:  The Release Reason defaults. 
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Example:  Below is a sample completed Invoice Actions window. 

 

10. Select the OK button. 

Result:  The Invoices window is displayed without the hold. 
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11. Select the Actions... button. 

Result:  The Invoice Actions window is displayed 
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12. Enable the Validate checkbox  

Example:  Below is a sample enabled validate checkbox. 
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13. Select OK. 

Result:  You are returned to the Invoices window and the status is Validated. 
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14. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 
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15. Enable the Pay in Full checkbox and select OK. 

Result:  The Enter Transactions Events window for the Payment workbench is displayed. 

 



 

Processing Travel-Related Payments   
 Chapter 5 - Page 32  

16. Click in the Transaction Event field and use the LOV to select the appropriate transaction 
event. 

Note:  Select AP Payments (Code B110) for travel vouchers.  Select Travel Advances 
(Code B206)  for travel authorizations. 

Result:  The Transaction Code field is populated. 

   

17. Ensure the correct transaction code defaults for the type of payment. 

Note:  B110 should default for travel vouchers.  B206 should default for travel 
authorizations. 

18. Select the OK button. 

Result:  The Payments - Pay in Full window is displayed. 
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19. In the Type field, use the LOV to select Manual. 

20. Tab to the Bank Account field and select Main Disbursement from the LOV. 

21. Tab to the Document field and select the appropriate document type from the LOV. 

Note:  Select the appropriate check document type with your initials.  If the incorrect type is 
selected, the cashier’s reconciliation will be affected. 

Result:  A note will appear indicating that payables is reserving the payment document. 

 

22. Select the OK button. 

23. Save the record by using the Save  button on the application toolbar. 

Example:  Below is a sample completed payment. 
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24. Close the Payments window. 

Result:  You are returned to the Invoices window. 

 

25. Select the Find  button on the application toolbar. 
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Result:  The Find Invoices window is displayed with the current invoice number in the 
appropriate field. 

 

26. Select the Find button. 

Result:  The Invoices window is displayed indicating the amount that has been paid. 
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27. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 

28. Enable the Print Notice checkbox 

29. In the Printer field, use the LOV to identify the correct printer. 

Example:  Below is a sample completed Invoice Actions window. 
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30. Select the OK button. 

Result:  A Note appears with your concurrent request ID 

 

31. Select the OK button. 

End of activity. 
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Practice Lab

Lab Time

 
Complete Lab 1:  Recording Travel-Related Payments 
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Voiding a Payment 
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Voiding a Payment 

After this lesson you should know how to:

• Process travel-related payments

Void a payment
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Voiding Payments 
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Voiding Payments

A payment can be voided if it was 
incorrectly recorded
Once the payment has been voided, 
it can be reissued using the standard 
procedures
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Voiding a Payment 

Purpose 

The purpose of this document is to describe how to void a payment in Accounts Payable.  In the 
event that you have located the payment already, you may skip steps 1 - 5. 

 
NIH Payables User 
NIH Payables Cashier Office User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter your search criteria in the Find Invoices window. 

Note:  Use the invoice number if available. 

2. Select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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3. Select the Payments button. 

Result:  The Payments window is displayed. 

 

4. Select the Payment Overview button. 

Result:  The Payment Overview window is displayed. 
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5. Select the Payments button. 

Result:  The Payments window is displayed. 

 

6. Select the Actions... button. 
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Result:  The Payment Actions window is displayed. 

 

7. Enable the check box Void. 

Result:  The current date defaults into the Date and GL Date fields. 

8. In the Invoice Action field, select Hold from the LOV. 

Result:  The Hold window will be displayed. 
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9. Select Void Payment from the LOV. 

Result:  The Reason field will populate automatically 

 

10. Select the Hold button. 
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Example:  Below is a sample completed Actions window. 

 

11. Select the OK button. 

Result:  A message appears to confirm that you want to void this payment. 

12. Select the OK button. 

Result:  The payment is voided.  The status of the payment is updated to Voided. 



 

Processing Travel-Related Payments   
 Chapter 5 - Page 48  

 

End of activity. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab 2:  Voiding Payments 
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Lesson Summary 
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Lesson Summary 

In this lesson you learned how to:

• Process travel-related payments

• Void a payment
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Important Dates and 
Information 
Chapter 6 
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Important Dates and Information 

Important Dates and Information

Track 2 End User Training
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NBS Track 2 Go-Live

September 1, 2003
NBS Travel System and supporting 
financial modules were deployed for 

entering FY04 travel documents

October 1, 2003 or when FY04 
funding is available

Financial transactions resulting from FY04 
travel documents will be processed
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Initial Oracle Set Up Required

The first time you log into the NBS, you will be required to:
Download Oracle J-Initiator and
Update your internet browser security settings

Refer to the technical guidance provided on the NBS
Technical website:http://nbs.nih.gov/technical.html
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NBS Travel Support Resources

NBS Travel Web links available 24/7
NBS Oracle Online Help and Ref erence:  http://nbs.nih.gov/training.html

NIH Portal Support
Phone NIH Help Desk at 6-HELP (301.496.4357)
Portal website address:  http://my.nih.gov

NBS Customer Support
Phone: Call 5-NBS7 (301.435.6277)
E-mail: Send e-mail to tasc@NIH.gov

Web Request f or Support: Submit to: http://support.cit.nih.gov

nVision
nVision is an ev olution of  the NIH Data Warehouse, and it is the new reporting sy stem designed 
to work in concert with the NBS. nVision is a business intelligence system that deliv ers NIH-
def ined standard reports and f acilitates the dev elopment of  user-created ad hoc reports to 
support decision-making and analysis. The f irst NBS module to be supported by  nVision is 
Trav el.
E-mail: Send e-mail to nVisionSupport@nih.gov

Web Site f or inf ormation: http://nvision.nih.gov
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Evaluation

Please take a moment to complete the 
on-line training evaluation

www.surveymonkey.com/s.asp?u=44111257699

Your comments are important to us!
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Good Luck

Good Luck!
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